
Twixtor for Vegas Pro

What is Twixtor?

Twixtor intelligently slows down and speeds up your image sequences.

Twixtor enables you to "time warp" your image sequences with visually stunning results. 
In order to achieve its unparalleled image quality, Twixtor synthesizes unique new 
frames by warping and interpolating frames of the original sequence... employing 
RE:Vision's proprietary tracking technology that calculates motion for each individual 
pixel.

Twixtor Features:

 Calculation of motion vectors at each pixel 
 Warping and interpolation of frames to "time warp" input footage 
 Stretching of a sequence using a single “speed” scaling parameter 
 Keyframeable retiming for complete control on a frame-by-frame basis. 
 Ability to mark cut points so that material with edits can be retimed or transcoded 

without breaking the material into pieces first 
 8 bits per channel and floating point image support.

Vegas version of Twixtor

Twixtor communicates with Sony Vegas via the Open Effects API (OFX). It requires 
Sony Vegas version 10.0d or over. Twixtor supports 8  and floating point processing. The 
plugin has been tested in 32 and 64b versions.  There is also a version of the product for 
all OFX hosts. If you have a key for that it will unlock this version Verify our website for 
hosts / versions currently supported as we regularly add more.

Things to Check Before You Start:

 Twixtor works most intuitively on progressive material and in projects, 
compositions or sequences that are specified to be progressive but it will still 
work with video fields (interlaced material like 1080i).



 If you have 3:2 pulldown in your source clip, you will want to remove 3:2 
pulldown before processing with Twixtor. If there is no motion between two 
frames then there will be no inbetweening. This is useful to know when trying to 
figure out why Twixtor doesn't apply proper processing to frames from a 3:2 
pulldown sequence or animation done on "2"s, etc.

 Twixtor works properly on material with fields
 Twixtor can handle different frame rates for the source clip and the output.  More 

on that later.
 Also it is recommended to disable the "Close media files when not the active application" 

preference in Vegas. Menu item: Options->Preferences; Click on the General tab. make 
sure "Close media files when not the active application" is OFF (no checkbox).  Not 
doing so can result in corrupted frames.

The  plugins  of  Twixtor are  installed  on  Windows  in  C:\Program  Files\Common 
Files\Ofx\Plugins . For your info, 

Starting a New Project in Sony Vegas
1. From the File Menu, choose New. The Project dialog appears.
Note: The fist time you run the software, a new project will automatically be started for 
you. 



2. Enter your project settings on the various tabs. For more information, see the 
Sony Vegas documentation.

(1) The Video tab allows you to select the video format and other video 
parameters.

(2) The Audio tab allows you to set up the basic audio settings. 
(3) Field order: allows you to select Upper Field First, Lower Field First, or 

None if it is a progressive project.
(4) Frame Rate: allows you to choose from popular pre-sets .

Tip: The easiest way to set the often-complex properties on the Video tab is to select a 
template that matches your clip (for example, NTSC DV (720x480, 29.970 fps)).

3. Click OK. 
4. From the File menu, choose Save. Type a name, browse for a location, and click 
Save to save your project (.veg file).
You can change project settings at any time while working on a project. From the File 
menu, choose Properties to change any of these settings.

Setting video properties based on a clip

You can automatically set your project video properties to match an existing clip.
1. From the File menu, choose Properties. 
2. On the Video tab of the Project Properties dialog, click the Match Media Settings 
button (A).
3. Browse for a clip that has the settings you wish you use for the project. 
4. Click Open.

The frame size, frame rate, pixel aspect ratio, and field order of this file are automatically 
detected and the project properties are set to match.
5. Click OK to save the new project properties.

Other video properties to check, as related to Twixtor
You can access project video properties by clicking the File menu and choosing 
Properties.  Final render properties set up in the Custom Template dialog override the 
following Properties settings:



• Pixel Format: Choose a setting from the drop-down list to indicate whether you 
want to perform video processing (compositing, scaling, previewing, rendering, and most 
video plug- ins) using 8-bit or 32-bit, floating-point arithmetic.
• Full-resolution rendering quality: Choose the Best option for Rendering quality 
although, Twixtor does not follow the rendering quality settings of Vegas. The only way 
to control the render time of Twixtor is to change the option in the Motion Vectors 
Quality menu within Twixtor.
• Deinterlace method: This drop-down list provides several options relating to 
interlacing. Source clip from a television is interlaced. When Vegas Pro software renders 
effects, it needs to deinterlace the two fields that make up a frame. You can choose the 
exact method used in this list:

• None Use this option for Progressive material.
• Blend Never use this option with Twixtor.
• Interpolate Use this option for Fields Based Material.

Note: If your project has video with Fields, set your Deinterlace Method to Interpolate 
Fields.

Once you have your Properties set, You should make a Subclip of the clip that you are 
adding Twixtor to. Making a subclip is useful because:  
• Non-destructive
• Defines the first frame of the clip (In Twixtor, Speed always works from the first 
frame.)



Using the Trimmer window

(1) Trimmer History
(2) Media File
(3) Splitter
(4) Loop Region

Creating a subclip
1. Select a clip from your Project Media and Rt-click to select Trimmer.
2. Create a selection in the Trimmer window. 

2. Click the Create Subclip button ( ). The Create Subclip dialog appears.

Tip: You can also right-click an event in the timeline and choose Create Subclip from the 

shortcut menu. 

Trimming a time selection
Trimming events removes all media outside the time selection. The removed information 
is not placed on the clipboard. Trimming is different from cutting in that the events 



within the time selection are preserved. After you have opened a clip in the Trimmer, you 
can select a segment of it and place it in your project timeline. 
Important Note: The first frame of your new time selection will become the first frame 
that Twixtor uses for the re-time.

(3)  In the Name box, type the name you want to use to identify the subclip in the Project 
Media window. 

(4)  Select the Reverse check box if you want the subclip to be played backward when 
you add it to your project. 

Click OK to create the subclip. You can then create events from subclip via the Project 
Media window.

Project Media Window

(1) Project Media Tab



(2) Subclip shown as a Thumbnail.  See Sony Vegas Manual for more information on 
using different Views and Managing your Project Media.

Adding Subclip to the timeline
Clips can be added to your project from the Explorer or Project Media windows by 
double-clicking them or by dragging them. Either method places the clip in an event in its 
entirety in the timeline.

Dragging a clip to the timeline

You can create a new track by dragging a clip to a blank area on the timeline and 
dropping it in place. Tracks can contain multiple events, so you can place different events 
next to each other on a track.
1. Locate a clip in the Explorer or Project Media window. 
2. Drag the clip to the timeline.
An event for the clip appears where you released the mouse.

Adding Twixtor to the Subclip

1. If the Video FX or Plug-In Manager window is not currently visible, choose 
either Video FX (1) or Plug-In Manager (2) from the View menu to view the 
appropriate window.
2. Drag Twixtor from the window to the subclip on the timeline



3. Alternatively (below), you can right-click (1) on the track in the timeline and 
choose Video Event FX (2)  and Twixtor (3).

Note: We suggest using Video Event FX instead of Media FX because with Media FX, 
your original length cannot be made longer.

Make clip desired result length
You can drag the edge of clip (1) to make it the desired length (2)



Note: If you are making the final result slower, you will have to make your clip the length 
of your new desired result.

Gotcha: You can Rt. Mouse Click on clip and go to clip Properties and make sure Loop 
is checked, otherwise last frame will hold for duration of clip.  You can see that the clip is 
looped by the notch (3) on the clip.

Usage of Twixtor

 We describe here the basic Twixtor usage. Check our website for tutorials.. 
help.revisionfx.com .

Display

1. Twixtored Output  : This setting displays the final Twixtor result. This setting has 
all the layers that you have specified (via mattes) retimed individually and 
composited back together. 

2. Source  : This setting displays the original color source; with no retiming done. 
This setting is particularly useful when setting Twixtor's Src: Mark Segments 
setting. 

Changing sequence timing.

Okay, now here's the meat of the plugin. How do I retime my clip?

Time Remap Mode: This menu has 2 options for the retiming method:

 Speed%   

When Speed is chosen as the Time Remap Mode, then you can set (and animate) the 
speed of the input clip. To obtain the speed of the clip, Twixtor gets the value from the 
Speed% slider. A value of 50 (percent) tells Twixtor to play the clip 1/2 as fast as the 
original, a value of 300 tells Twixtor to play the original clip at 3 times its normal rate.

You may ask "I know that I want to change the duration of the clip by a certain amount,  
how do I figure out how to set the Speed setting?"

http://help.revisionfx.com/


In general, if you have a constant factor for a duration change, set Speed% to: 100 / 
(duration change)

 For 2X duration change, set Speed% = 100/2 = 50% 
 For a 0.5 duration change (speed up), set Speed% = 100/0.5 = 200% 

Valid Speed% settings are from -10,000% to +10,000 (that is -100 to +100 times original 
rate). However, the initial slider display in most host applications will be -1000% to 
+1000% (-10 to +10 original rate). Note that you can type in a higher value even though 
the slider shows a smaller range than the valid range.

Note on negative speed: A Speed% of -100.00 does not simply flip the original sequence 
so that it plays backwards starting at frame 0. Imagine the play head on your clip. If you 
are at the beginning of the clip and you tell the machine (Twixtor in this case) to start 
playing backward, then there's nothing before the clip starting position to play. That's 
why you will not see a result with a negative speed as the first keyframe. If you play the 
clip at 100% for a while, then put in a –30% keyframe (or other negative value) at the 
place where you want to start playing backward you will see proper results.

Note on Animating Specific to Sony Vegas: 



(1) Animate Icon – Select this icon to see the Keyframe controller at the bottom of the 
Video FX window.
(2) Sync Cursor – Select this icon to sync the keyframe curser with the timeline cursor. 
Note that this can also be a “Gotcha” so,  Beware!
(3) Lanes – The Interpolation curve determines the rate at which Twixtor animates 
between two keyframes.  Right-click a keyframe to choose a different shape for the 
interpolation curve. The shortcut menu has six options; Linear, Smooth, Fast, Slow, 
Sharp, and Hold.



(4) Curves – In the Curves view of the video effects keyframe controller, you can 
manually adjust a keyframe’s spline curves with manual selected and you can adjust the 
handle (5).

Frame Num 

If Frame Num is chosen, then Twixtor knows you'll be keyframing your time 
resequencing by exact frame numbers. Twixtor looks at the value of the Frame Num 
slider to figure out what frame from the input sequence to compute, even if it's a 
fractional value.

This section describes keyframing the remapping of time using frames. Again, let's 
assume that the input frame rate is the same as the output frame rate.

If you wish to keyframe the timing using direct frame numbers specification, then make 
sure Time Remap Mode is set to Frame Num. The Speed% setting is ignored in this case, 
and the Frame Num parameter is used instead. The value of the Frame Num parameter 
tells Twixtor which input frame should be returned for the current time (fractional values 
are interpolated as described in the previous section).

To use the Frame parameter for retiming:

Immediately after applying Twixtor to a clip, it is advisable that you:

First, make the Frame Num parameter animatable.

Second, you are advised to make keyframes for the Frame Num parameter as follows:

 make a keyframe with value 0 at time 0 
 make a keyframe at the last time value in the sequence, with a value equal to the 

last frame number 

For example: Let's say you have a sequence of 300 frames.

 make a keyframe with a value of 0 at time 0 
 make a keyframe with value 300 at time 300 (time, in this case, is in "frames" 

instead of timecode). 



This will give you an identity mapping (frame 0 returned at time 0, frame 300 returned at 
time 300, frame 47 will be returned at time 47, etc.).

If Time Remap Mode is set to Speed% then the Frame Num parameter is ignored. 
Conversely, when the Time Remap Mode is set to Frame Num, the Speed % slider is 
ignored when key-framing destination frames." TIP: If you are doing a complex dynamic 
remapping of the video action, you can quickly set your key-frames by setting Motion 
Vector Quality to None and Frame Interp to Blend. When done setting keyframes, you 
can go back and set the Motion Vector Quality to the desired quality.

Track Control

Motion Vectors: A menu option with 5 choices for determining the quality of the motion 
vector calculation.

1. No Motion Vectors  : no motion vectors are calculated 
2. Sloppy  : motion vectors are calculated at 1/4 resolution. Furthermore, a faster but 

less accurate method is used. 
3. Medium  : motion vectors are calculated at 1/4 resolution. 
4. High  : motion vectors are calculated at 1/2 resolution. 
5. Best  : motion vectors are calculated at full resolution.

Important: How output frames are calculated. For demonstration purposes, let's 
assume that we are slowing down a clip by a factor of 3 (Speed% set to 33.3333). As 
such, output frame 25 would conceptually need input frame 8.33333. How is frame 8.333 
calculated?

 Case 1: Frame Interp: Nearest with Motion Vector Quality: No Motion Vectors. 
In this case, no warping can occur (there are no motion vectors!), so the closest 
input frame in time (input frame 8) is returned. 

 Case 2: Frame Interp: Blend or Motion Weighted Blend with Motion Vector 
Quality: No Motion Vectors. In this case, no warping can occur (there are no 
motion vectors!). However, we've asked the module to blend frames, so we'll get 
a return frame that is a dissolve of frame 8 (at 67%) and frame 9 (33%). This is 
similar to Final Cut Pro with frame blending turned on. 

 Case 3: Frame Interp: Nearest with Motion Vector Quality set to anything other 
than No Motion Vectors. The motion is calculated from input frame 8 to input 
frame 9. Frame 8 is then warped using the motion calculated (scaled by 1/3) and 
returned. 

 Case 4: Frame Interp: Blend or Motion Weighted Blend with Motion Vector 
Quality set to anything other than No Motion Vectors. The motion is calculated 
from input frame 8 to input frame 9. Frame 8 is then warped using the motion 
calculated (scaled by 1/3) and returned. Frame 9 is warped using the motion 
calculated from frame 9 to frame 8 (scaled by 2/3). Finally, these two warped 
frames are blended as in Case 2. 



Note that if fewer frames are being generated for the output sequence, that is, the input 
sequence is being speed up (total time duration is shrunk) OR a lower output frame rate 
than input frame rate is specified, then motion blur may then be applied (see Motion Blur 
option below).

Image Prep: A menu option with 2 choices 

1. None   
2. Contrast/Edge Enhance   

The default image preparation is to do nothing special with the source material that is 
used for tracking. If your material is dark or has poorly defined edges then Twixtor 
might perform better if you choose Contrast/Edge Enhance. Note that the Contrast/Edge 
Enhance setting may perform more poorly than using the None setting on material that 
already has reasonable contrast or has many thin edges close together.

Motion Sensitivity: this setting will be explained later in this document.

Frame Interp

A menu option with 3 choices.

1. Nearest  : warps the nearest calculated input frame by the right amount to make the 
current output frame. 

2. Blend  : Performs bi-directional warping and then blends the resulting two warped 
images. The more you stretch a clip, the more this choice is recommended. 

3. Motion Weighted Blend  : When a new frame is created from existing frames it is 
often the case that some softening is introduced. This softening can be more or 
less strong (depending on how far away in time the new frame is located from 
existing frames in the original sequence. This can result in a pulsing of what 
appears to be the Twixtored sequence coming in and out of focus. The Motion 
Weighted Blend option attempts to reduce this pulsing. 

Smart Blend

Smart Blend gives better results on a pan or zoom or other clip where objects (or parts of 
objects) are entering or exiting the frame. When this option is off on such shots, you 
might get pixels that smear at the edge of the frame. When turned on, this option can 
produce much better blending when objects are moving off screen. This option will 
increase the calculation time and is only necessary on certain shots (like shots with pans 
and zooms with greater than 5% ), so that’s why it’s an option.



Frame 1 Frame 2
Slow Mo 5x without 
Smart Blend. Note 
streaking on right edge of 
Twixtor created frames.

Slow Mo 5x with Smart 
Blend.

Warping 

There are 2 Warping settings.

1. Inverse  : Inbetweened warped images are calculated using an inverse mapping 
method. This setting is much faster than the Forward setting. This is the method 
that the regular version of Twixtor uses (and is the default setting for Twixtor 
Pro). It is often better to use this setting when 

o portions of objects are not moving off the edge of the image (or onto the 
image from offscreen) 

2. Forward  : Inbetweened warped images are calculated using a forward mapping 
method. This method is slower than Inverse, but can produce much less ghosting. 
The forward method includes the Smart Blend method. It is often better to use this 
setting when 

o you are using extreme slow motion (more than 3x slow down) and 
inbetween frames do not produce desirable results (ghosting or "sliding" 
of imagery can occur if you use the Inverse method). 

Motion Blur Compensation     

When speeding up a clip, you are essentially telling Twixtor that there is "more action" 
happening per frame. In order to simulate what happens in a real camera, and to reduce 
flickering, Twixtor applies motion blur when speeding up footage in order to simulate 
what happens when more motion takes place in the same amount of (virtual) shutter 
opening of a camera. You can dial in how much motion blur is added with the Motion 
Blur Compensation slider.  Twixtor also compensates for motion blur by removing 
motion blur when slowing down footage. Note that the removal of motion blur may be 
more or less effective depending on how much blur there is in the original sequence.

The default setting for Motion Blur Compensation is 0.0 (that is, by default there is not 
motion blur compensation). A value of 0.5 is a good place to start if you wish Twixtor to 
automatically compensate for motion blur (this assumes a shutter angle of 180 degrees).



Note that the application of motion blur in Twixtor only occurs when footage is sped up 
or slowed down, to compensate for different virtual shutter speeds. This is different from 
our ReelSmart Motion Blur product, which adds motion blur based on the motion 
calculated in a sequence without speeding up or slowing down the footage.

When I retime the footage I'd like Twixtor to respect information I know about the 
source material. How do I do that?

When you retime the footage you may notice that Twixtor inappropriately morphs across 
a hard cut edit in the source material. Or there may be a section of the footage, such as a 
dissolve, where you know frame blending without any motion vectors would produce 
better results. Because of these situations we have provided the following setting.

Src: Mark Segments 

This setting allows you to specify information you know about the source material. When 
animating this option, make sure to do it when Display is set to Source.  Application like 
Nuke who don’t support animated menus will see a second control (a popup) to help 
automatically set integer values. Note as well that the tidbit info that displays when you 
rollover this parameter lists the values. Be careful that this is not interpolating between 
key-frames.

Twixtor will not interpolate between two segments marked with different Cut settings. 
For example, if one frame is marked as part of Cut A and the next frame is marked as part 
of Cut B, then Twixtor will not interpolate between the two when time remapping. In 
fact, let's say frame 10 is part of Cut A and frame 11 is part of Cut B. Let's say Twixtor is 
asked to slow the footage down: if Twixtor is asked to make frame 10.4, then instead of 
taking 60% of frame 10 and 40% of frame 11, Twixtor will simply return frame 10. If 
Twixtor is asked to make frame 10.6, then frame 11 is simply returned. In fact, when two 
adjacent frames are marked as part of different cuts, Twixtor simply returns the nearest 
frame in the source instead of blending between the two frames. However, when two 
source frames to be interpolated are marked with the same Cut setting, then the Motion 
Vectors and Frame Interp settings will be used to interpolate between the two frames to 
create the output frame.

Special Case – When you want to apply Twixtor to a clip with fields and it is in a 
progressive project, what do I do?



If you are adding a clip with Fields to a Progressive project, these are the steps you need 
to take:
1) Drop the “Fields” clip (1) into your timeline where you want it and add Twixtor  as 
normal except there is an additional step.   
2) Rt. Mouse click on “Fields” clip and select Properties and change Playback rate to 
0.5  (1) to see both fields. If you don't set the Playback Rate Vegas will skip every 2 
fields so you will have less information to work from for Twixtor.

Note: Within Twixtor, you will now have to compensate Speed by 2X. Example: If you 
want clip to be 10% slower, you will need to make it 20% or if you want clip to be 50%, 
you will make it 100%, etc..

The tracking is not working so well on my source footage, what can I do?

Tracking problems show up as motion not being properly tracked: either objects in the 
output sequence "gloop" together, or objects don't move enough causing what seems to 
be simple cross dissolves of the input images. (for what constitutes problems for our 
tracker, see the "PROBLEMS IN INPUT SEQUENCES" section below.

Motion Sensitivity
Okay, you might say "I don't have time to experiment with image processing my footage 
to specify an alternate motion source," or worse, "I try to color correct my footage and it 
does not help the tracking!" If objects still "gloop" together when they shouldn't, then you 
can try manipulating the Motion Sensitivity parameter. Motion Sensitivity limits how 
much pixels can move. A value of zero assures that pixels can't move very much, and a 
value of 100 allows pixels to move as much as the motion interpolator can calculate.  The 
default value of 70 might sometimes be a bit too "ambitious" for some material... by 
reducing the sensitivity you might be able to create a more interesting result (giving a 
more traditional frame blended look) where there is large motion rather then some sort of 



inappropriate swirl that Twixtor might introduce. Conversely, if there is only one object 
in the scene and it moves in large amounts, the default value of 70 may not be ambitious 
enough. 

 SHOOTING FOR TWIXTOR

A common question here is what is the best camera settings so we get the best Twixtor 
results. Many cameras offer aside control for the shutter speed, options for FPS, 
resolution, compression rate, progressive or interlaced modes. 

A general rule of thumb would be the more frames per second you have the better. That 
would be 720P 60 FPS is recommended over 1080P 24 FPS for example, or even 1080 
60i over 1080 30P. Also the shortest possible shutter speed resulting in the less possible 
motion blur streaks in the image will help Twixtor as well. Of course the "thruthness" of 
all this is relative to does these settings produce without Twixtor a good image quality. 
Fast exposure in not as well lighten areas can create annoying video noise, or some 
cameras might compress too much the image at higher frame rates...   

You might notice some people that  shoot on a skateboard their friend jumping off a cliff 
on a trick bike... So sports in general (fast action) is the type of footage that in general 
benefit from more FPS. It is so because if you have 2X more frames to start Twixtor only 
has to look within a window twice as small to match to create the in-between. More 
frames per second also makes it more robust for objects closer to the camera... A 
fundamental reason is basically the less pixels travelled between two frames. The worst 
case for Twixtor being someone running sideways close to camera. 

Some camera manuals will tell you to shoot with longer shutter speed  and we just say the 
less motion blur the better for the motion analysis. Some people actually use our RSMB 
regular (ReelSmart Motion Blur) after the fact to create a more filmic look. 

So, If your options are 720 60P and 1080 30P - go 720 60P if you want to do slowmo... 
That is, resizing 1.5X is safer then inbetweening 2X more frames. For someone else who 
has 1080 60i and 1080 24P, for twixtor 1080 60i will usually be better (usually = unless 
some guy wears a checkboard shirt).. Of course there is a limit to that logic, if your 
DSLR can do 300 FPS at 320x240 pixels and you need to export a 1080P project, well 
OK the slow-mo will be perfect but there will be major spatial resolution issues. 

PROBLEMATIC FOOTAGE

If you have not used Twixtor yet, this section might prove to be a little bit esoteric. This 
information will be of more use to you as you become more familiar with Twixtor and 
want to understand how to generate the best possible results.

It might happen that Twixtor might do poorly in specific instances. The idea here is not 
to discourage you and tell you it does not work but, rather, to give truth in advertising. As 



you become an expert user, you learn to predict the kind of material that can cause 
problems.

1. "Picket Fence": A very regular pattern in motion (for example someone wearing a t-
shirt with fine stripes) with an object moving in front of it (e.g. the same person hand for 
instance) might confuse the motion vector calculation. Any very structured pattern 
rotating like a wheel rim can cause "blind spots" for the analyzer at certain FPS.

2."Transparency": Overlay of semi-opaque surfaces might create unexpected results. For 
example if you shoot a fish bowl and people pass in the back and there is some scene 
reflection on the front, at some point the in-between might not look accurate. Some 
cameras for example will streak under fast motion and that can create disappointing 
tracking results. 

3."Short Interval Defects" : Sudden global illumination change (e.g., a flash), strobing, 
dust, ... can create unexpected / undesired results. Also,if there is a piece of hair or a 
scratch on the scanned film for a frame this would influence the tracking so you really 
should try to clean such defects before processing.

4."Fields": We provide some basic field handling. Always remember that by definition, 
even and odd scan lines in material with fields are considered half a frame apart 
timewise. Because fields are spatially a line offset from each other, regions where there is 
no motion and horizontal lines might produce a slight up and down motion in phase with 
the source frame rate.

5."Duplicated Frames": Twixtor does not provide automatic duplicated frame detection 
support. As such, you will need to remove duplicated frames before the application of 
Twixtor. Also, you should be aware that if your material has 3:2 pulldown you should 
remove it beforehand. The same applies to animations on 2's. If you leave the duplicate 
frames (or fields, in the case of 3:2 pulldown) the freeze-frame, inherent in the 
duplication of the frames, will be stretched (or sped up, as appropriate).

6.     "Alternate Motions": When motions going in different direction are layered it is 
possible that the dominant motion affects (spills into) the background motion.

7."Specular Highlights": If you have moving lights, e.g., a shiny object that reflects the 
light as it moves, it might cause problems because when the motion estimator attempts to 
match two images, as the motion estimator will tend to follow the highlight as if it was an 
object. (of course, sometimes this is what you want). Same with lens flares and other such 
optical phenomenas.

8."Ultra-Fast Structured Motion": We are very particularly perceptive to human actions. 
We have sometimes seen that certain complex rapid motion such as someone doing a 
frenetic dance creates interframe displacements combined with camera motion that are 
just too big for our motion estimator to resolve satisfactorily. When planning a shoot for 
an effect that involves Twixtor in the pipeline, consider that for Twixtor fast articulated 
motion should be easier for front facing subject then sideway views as there will be less 
pixels traveled per frame on the screen, which is really the only thing that Twixtor cares 
about.



9."Occlusions": Problems caused by object motions tend to be one frame problems and 
localized in an area of the frame which is called an occlusion, which is some pixels that 
you see on one frame but are not visible on the other as a result of camera and/or that 
object motion. A cluster of american football or rugby players will often end up with an 
hand coming out for a frame then disappearing... This sort of multi-layered clutter is 
really when more FPS is the most useful.

10. “Limited Reach”: As a rule of thumb considers that Twixtor will be most accurate for 
pixel displacements that are a maximum of 5% of your image resolution (for 720x486, 
this comes to a maximum horizontal displacement of 35 pixels or so). With 
displacements larger than that Twixtor will start to become less precise as it tries to 
separate motions from one another in an image sequence. Consider as well that the 
motion cumulates the object motion and the camera motion, so if your camera moves the 
opposite way then the action it creates much larger per frame displacements.

11."Noise and Compression Artifacts": Certain video coding techniques such as DV 
compressors use 8 by 8 pixels blocks (intraframe) based compression. What this means 
for you is that if for instance you have a sharp edge that moves, it will switch of 8 by 8 
block and therefore locally it's neighbor values will be all different (substantially not like 
2-3 values over 255 but sometimes 40 off near an edge). This is why green screen like 
setups perform badly with DV...Without smoothing the source, this can sometimes 
certainly create tracking problems. The same apply to image sources with a lot of video 
noise, the motion will suddenly track noise and creates unwanted noise smearing with 
very large slowmos.

MORE AESTHETIC / COSMETIC CONSIDERATIONS:

Gee! It breaks on these 3 frames what do I do?

* All solutions mentioned are not necessarily available as OFX plug-ins at this time.

Now that we have set the level of expectations to make clear that sometimes there will be 
some issues, let's help you to be creative in repairing problems. We know that most of the 
time, there is nothing we can do to prevent problems at the source because the material 
already exists, and you need to fix it. So let us share a bit our experience. Experience we 
acquired playing with this kind of process in production, in trying to make a product that 
works, and in supporting our users. There is an astronomic quantity of possible images 
and it's easy to develop assumptions that prove not true if you always work on the same 
few clips. So, so you know we fully appreciate short movies (5 frames is usually enough) 
where Twixtor fails somehow, this is how we learn, and can hope to make an always 
better product. 

Often as well we noticed that the most successful short movies users are those that try 
many things and keep what works best.

1.1 or 2 frame defects on source material: Sometimes you receive a movie with one or 
two frame defects (could be a flash for instance). Take the good frames on both ends of 



the bad ones and slice them together into another project, create a short Twixtor clip of 
the proper duration and reinsert it back over the bad frames. Naturally if you also want to 
apply Twixtor to the whole movie, perform the repair before applying Twixtor to the 
whole sequence.

2.Splotches:  Although we try to accommodate for separate layers with the Crossing 
Objects?/Separate Motion? button there are times when you will still get some splotches 
(unwanted warping artifacts).You can try one of two things:

 You can animate the Motion Vector Quality menu so that it is set to Best for the 
non-problematic areas and set to None for the problematic areas. If your problem 
only occurs in a small part of the image, you can hand-create a very soft matte to 
replace the bad portions of the "Best" version with the corresponding parts of the 
"No Motion Vectors" version, using the compositing functions of your 
application. You might want to do a soft matte for nice blending. 

 Try turning down the Motion Sensitivity setting for the problematic portions of 
the image sequence. 

3.Ghosts: Since errors such as ghosting are usually due to occlusions (pixels that were not 
visible in the previous frame, so don't have correspondence in the other frame due to 
motion), they are usually easy to paint out so when the result is played in motion no one 
will see it. Some camera motion such as driving on a bridge and shooting off the window 
tend to create a multi-frame ghost which usually is not too problematic to paint out in 
apps like Commotion or Combustion that have clone offset paint tools. You might also 
prefer to not apply motion blur at this stage, paint/fix and then use ReelSmart Motion 
Blur to add some motion blur.

4.Using existing mattes: Sometimes, rotoing out a fast moving foreground object will 
make the background very stable and produce tracking without the foreground motion 
influence. If you have the luxury of having mattes for a layer, you might want to try to 
apply Twixor to the foreground and background separately (so that the motion tracking 
influences on the layers go away or are reduced by Twixtoring them separately). Note in 
some cases you would need to fill the foreground hole with some form of clean plate 
image so it has the general motion of it's surrounding area.  

5.Shakes...: When you slowmo something you will also slowmo the camera shakes and 
vice-versa, so if you have hand-held footage you might consider to pre-stabilize the 
sequence on which you want to apply Twixtor.

6.Noise, compression artifacts: Our algorithms should not be too sensitive to small grain 
noise at the analysis level, however it might look weird to extrapolate a lot of frames per 
frame on material that contains a lot of noise (as it essentially slows down the noise also) 
so you are advised to remove some noise in the color source, perhaps running a form of 
smoothing or noise-reduction filter before. With material (such as some “really damaged” 
MPEG 1 material), lower accuracy motion estimation might even produce more desirable 
results. Also with DV-like sources, avoid Nearest as Frame Interp mode. The smoothing 
of blending actually reduces noise.



7.Very Large SlowMo: The amount of clean frames you can generate is often more a 
factor of the action in the scene as there is probably no answer to the question of how 
many frames can be inbetweened with a process like this, as it depends... As a rule of 
thumb, after 5% of the image size displacement for a single frame, consider yourself 
lucky if it works. (Again there are no absolute answers). Perhaps also you should 
consider that there is a limit to how much you slow down things as even perfect 
inbetweening will result in footage where everything sorts of move at the same rate.

8.Softening: Another related thing to watch out is that you will notice that inbetweens 
will “soften” the texture details. The thinking is that it's sort of OK as you don't need as 
much detail on moving elements (you assume you will have some motion blur) and the 
image where it does not move will remain very clear. If unwanted softening occurs, and 
the Weighted Blend is not enough, you can consider little post tricks including slightly 
sharpening (maybe simply an unsharp filter, such as one found in our SmoothKit plugin 
set) and adding a bit of noise... Depending on what you are doing this might be more or 
less realistic.

9. Handling Multiple Motions: A "rough" garbage matte roto that isolates the foreground 
object might be necessary on the few frames where the problem occasionally occurs. 
After applying Twixtor 2 times to the frames with the garbage matte (on  foreground 
pass), the inbetweened frames can be recomposited back together. When you make a 
garbage matte for this purpose, you can typically be a bit  "more fat" than the usual roto 
matte for compositing.  

10.Fast Action: So, with fast action content, you will probably get better results with 
Twixtor from material captured with a 60i FPS camera than with a DV camera that does 
12 of 15 real FPS, because the same action will move farther per frame in the 12fps 
footage than in the 30fps footage. If you have the option of shooting progressive or 
interlaced video, a basic rule of thumb might be if you have fast action (or because you 
are running with a hand-held camera) shoot interlaced (because we construct 60fps from 
the 60 fields, which gives us more frames to deal with, which reduces the motion per 
frame), otherwise shoot progressive (because we don't have to reconstruct a frame from a 
field, you will get better quality results).

11.Changing Field Order:  If you see a regular stutter (the action seems to go forward and 
backward) then maybe your field order in the Property of the Clip in the Project Bin is 
incorrectly set. Change lower to upper first or vice-versa to see. 

12.  "Film Look" and Other Fields Related Problems: For more on our products and "film 
look" issues, please read our film look FAQ (located here).

Twixtor, ReelSmart, FieldsKit and SmoothKit are trademarks of RE:Vision Effects, Inc.
Other product names might be trademarks of their respective owners.

Copyright 2000-2011 RE:Vision Effects, Inc.

http://help.revisionfx.com/task/23/
http://www.revisionfx.com/smok.htm
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